
 
 
 

 

 

 

 

 

CREST Cyber Olympiad (CCO) 

Class 8 (Set - A) 
 

Time Allowed: 1 hour                                          Maximum Marks: 60 
 

• Additional 10 minutes will be allotted to fill up information on the OMR Sheet, before the 

start of the exam. 

• Fill in all the mandatory fields clearly on the OMR Sheet.  

• There are a total of 50 questions in this booklet comprising 2 sections namely  

the Computer & IT and Achievers' Section consisting of 40 questions (1 mark each) 

& 10 questions (2 marks each) respectively.  

• There is no negative marking. The use of a calculator is not permitted. 

• There is only ONE correct option to a given question. 

• Use HB Pencil / Ball point pen (Blue / Black) only for marking the correct choice of 

answers on the OMR Sheet. 

• Rough work is to be done in the space provided in the test booklet. Extra plain sheet may 

be provided by the school for the rough work.   

• The OMR Sheet is to be handed over to the invigilator at the end of the exam. 

• No candidate is allowed to carry any textual material, printed or written, bits of paper, any 

electronic device, digital watches, etc. inside the examination hall. 

• The use of unfair means may result in the cancellation of the exam. Any such instances 

must be reported at +91-98182-94134 or info@crestolympiads.com 

 

DO NOT OPEN THIS BOOKLET UNTIL ASKED TO DO SO 

 

 

Candidate Name: _______________________________________________ 

Class: _________ Section: ____________________________________ 
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1. Fill in the blank: 

______ is a technique that is used to 

send more than one call over a single 

line. 

 

a. Digital transmission 

b. Infrared transmission 

c. Digitising 

d. Multiplexing 

 

2. Complete the following sentence: 

In HTML, colours can be specified 

by___________. 

 

a. using colour names such as Red, 

Blue, and Green etc. 

b. using RGB values of the colours 

c. using HEX values of the colours 

d. All of the above 

 

3. Identify the cable shown in the image 

below: 

 

 

 

 

 

 

a. Ethernet Cable 

b. Coaxial Cable 

c. S Video Cable 

d. Digital Cable 

 

4. Fill in the blank: 

The image below displays some of the 

default bullets in MS Word. Michael 

wants to use a different symbol as a 

bullet for his document, he should use 

the ___________. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

a. Create New Bullet option 

b. Define New Bullet option 

c. Paste the image as an option 

d. Add New Bullet option 

 

5. Fill in the blank: 

A specialized program that allows users 

to utilise in a specific application is 

classified as ________. 

 

a. relative programs 

b. application programs 

c. replicate programs 

d. patch programs 

 

6. Fill in the blank: 

System software performs various types 

of functions such as _________. 

 

a. storage management 

b. allocating system resources 

c. process management 

d. All of these 

 

7. The mouse properties dialog box in the 

control panel has many buttons to 

change the appearance of the mouse 

pointer on the computer screen. Which of 

the following buttons is/are available in 

mouse properties dialog box? 

 

a. Buttons b. Pointers 

c. Wheel d. All of these 

 

Computer & IT (Each Question is 1 Mark) 
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8. What is the name of the application used 

to manage files and folders in Windows 

Operating System? 

 

a. Internet Explorer 

b. Document Explorer 

c. Windows  

d. File Explorer 

 

9. Which one of the following files is used to 

start the MS Word application? 

 

a. Winword.exe 

b. Wrood.exe 

c. MSWord.exp 

d. Word.exp 

 

10. Fill in the blank: 

The space left between the margin and 

the start of a paragraph is called 

_________. 

 

a. spacing b. gutter margin 

c. indentation d. alignment 

 

11. Fill in the blank: 

In the MS Excel worksheet, the cell 

reference of the cell range from B2 to 

G15 will be written as ________. 

 

a. B2.G15 b. B2;G15 

c. B2:G15 d. B2-G15 

 

12. The functions in MS Excel must begin 

with which of the following symbol? 

 

a. An equal to sign 

b. A plus sign 

c. A greater sign 

d. A bracket sign 

 

13. Fill in the blank: 

In MS Excel, the process of arranging 

the items of a column in some sequence 

or order is known as ________. 

 

a. Sorting b. Autofill 

c. Filtering d. Alignment 

 

14. In MS Excel, which one of the following 

denotes a range from B1 through B6? 

 

a. B1-B6 b. B1 to B6 

c. B1:B6 d. B1$B6 

 

15. Which one of the following keys is used 

to open the replace box in MS 

PowerPoint presentation? 

 

a. Ctrl + H b. Ctrl + F 

c. Ctrl + G d. Ctrl + J 

 

16. Which of the following is not a View in 

MS PowerPoint? 

 

a. Slide Sorter View 

b. Presenter View 

c. Presentation View 

d. Outline View 

 

17. PowerPoint is used to create interactive 

presentations. To create new slide in 

PowerPoint which of the following can be 

used? 

 

a. Home tab → Slide group → New 

slide 

b. Home tab → Slide group → 

Clipboard → New slide 

c. Home tab → Drawing group → New 

slide 

d. Home tab → Editing group → New 

slide 

 

18. Which one of the following is a two-layer 

protocol that manages assembling of 

messages or files that need to be 

transmitted over the Internet? 

 

a. HTTP b. Wi-Fi 

c. NETBUI d. TCP/IP 

 

19. John has dragged the mouse from cell 

location F3 to H20. What cell number will 

be displayed in the name box? 
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a. F2 b. F3 

c. H21 d. H20 

 

20. Fill in the blank: 

A kilobyte also referred to as KB, is equal 

to ________. 

 

a. 1000 bytes b. 1024 bytes 

c. 2048 bytes d. 512 bytes 

 

21. Which among the following is the lowest 

form of computer language? 

 

a. Assembly Language 

b. Machine Language 

c. COBOL 

d. Perl 

 

22. Which of the following is the correct use 

of bookmarks? 

 

a. To correct the spellings 

b. To jump to a specific location in the 

document 

c. To ignore spelling mistakes 

d. To save alignment as it is 

 

23. Which of the following operating system 

is produced by IBM? 

 

a. OS-2 b. Windows 

c. DOS d. UNIX 

 

24. Under which group of the Review tab of 

the MS Word Ribbon do you find the 

Thesaurus? 

 

a. Proofing b. Protect 

c. Compare d. Changes 

 

25. Fill in the blank: 

A remote computing service involves the 

use of timesharing and _________. 

 

a. multiprocessing 

b. interactive processing 

c. batch processing 

d. real time processing 

 

26. Fill in the blank: 

A website is a collection of webpages. 

_______ connects webpages in a 

website. 

 

a. Connector b. Link 

c. Hyperlink d. Association 

 

27. Which command will you choose to 

convert a column of data into a row in 

MS Excel? 

 

a. Paste Special 

b. Format Painter 

c. Transpose 

d. Paste Link 

 

28. Fill in the blank: 

In context of MS Excel worksheet, 

comments put in cells are called 

_______. 

 

a. Smart Tip b. Cell Tip 

c. Web Tip d. Soft Tip 

 

29. Which of the following correctly relates to 

Von Newmann bottleneck? 

 

a. An instruction fetch and a data 

operation cannot occur at the same 

time 

b. It has one dedicated set of address 

and data buses for reading and 

writing to memory 

c. It has one set of address and data 

buses to fetch instructions 

d. None of the above 

 

30. Fill in the blank: 

_______ is a feature that automatically 

adjusts the amount of space between 

certain characters of a word typed in a 

font like Times New Roman so that the 

entire word looks more evenly spaced. 

 

a. Kerning b. Spacing 

c. Scaling d. Positioning 
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31. Fill in the blank: 

A '$' sign in a cell reference like $A$3 

means that ________. 

 

a. the cell reference is absolute 

b. the cell is formatted to dollars 

c. the cell reference is relative 

d. the cell reference is invalid 

 

32. Which of the following is a valid cell 

range? 

 

a. A1.C3 b. A1:C3 

c. A1;C3 d. A1-C3 

 

33. Complete the following sentence: 

When you hide a slide in PowerPoint 

presentation, the hidden slide 

____________. 

 

a. contents are deleted 

b. is deleted 

c. content is hidden and a blank slide 

will be displayed 

d. is not displayed in the slideshow 

 

34. There is a collection of tables contained 

in an MS Access database. To create a 

table which of the following is 

necessary? 

 

a. Indicate the type of data that can be 

stored in the field. 

b. Indicate the type of table used. 

c. Indicate from where information is 

taken. 

d. All of the above are necessary 

 

35. Fill in the blank: 

Barcode readers use _______ 

embedded in them to read bar codes. 

 

a. co-processors 

b. magnetic cells 

c. RFID microchip 

d. photoelectric cells 

 

36. What do you call the program which is as 

permanent as hardware and is stored in 

ROM? 

 

a. Hardware b. Software 

c. Firmware d. ROM ware 

 

37. After choosing a predefined template, 

which option helps you to change the 

background colour in a PowerPoint 

Presentation? 

 

a. Design Template 

b. Colour Scheme 

c. Animation Scheme 

d. Colour Effects 

 

38. Which of the following type of computers 

are used for weather forecasting? 

 

a. Analog computer 

b. Digital computer 

c. Hybrid computer 

d. Super computer 

 

39. Which of the following is the correct 

HTML code for inserting a named 

anchor? 

 

a. < LINK = IMAGE.HTML > < /A > 

b. < HREF = ANCHOR1.HTML > < /A > 

c. < A HREF = IMAGE.HTML > < /A > 

d. < A NAME = "IMAGE" > < /A > 

 

40. Fill in the blank: 

By default, an image in HTML will align 

at the left side of the page. This 

alignment can be changed by using 

________ attribute to set it to the centre 

or right. 

 

a. Centre b. Right 

c. Align d. Locate 

 

 

 

http://www.crestolympiads.com/


 
 

 
Copyright © CREST Olympiads                              5                              www.crestolympiads.com 

 

 

 

41. Unix is a family of multitasking, multiuser 

computer operating systems that derive 

from the original AT&T Unix, whose 

development started in the 1970s at the 

Bell Labs research centre by Ken 

Thompson, Dennis Ritchie, and others. 

Which of the following is not related to 

Unix? 

 

a. It is a multi- user CLI operating 

system. 

b. It is used on mainframe (large 

computer system). 

c. It uses a command line interface. 

d. It was introduced in 1945 

 

42. If you want to convert a symbol or 

several lines of text into an AutoCorrect 

entry, which of the following option you 

should use? 

 

a. Insert the symbol or type the text in a 

Word document first. Then, select the 

text or symbol and go to the Auto 

Correct dialog box. 

b. Auto Correct can only accommodate 

one line of text. It is not possible to 

convert a symbol or multiple lines of 

text into an Auto Correct entry. 

c. Insert the symbol or type the text in a 

Word document first. Then, select the 

text or symbol and click the Edit 

menu followed by Paste Special. 

Select New Auto Correct Entry and 

then click OK. 

d. Click the Tools menu and choose 

Auto Correct Options. Then, click the 

Insert menu and choose Symbol (or 

click the Format menu and choose 

Paragraph) to add the symbol or 

paragraph to Auto Correct. 

 

43. Which one of the following statements 

are true in context to MS PowerPoint? 

 

Statement 1: If you choose to select 

from one of the pre-made slide layouts, 

you can change the positioning. 

Statement 2: If you choose to select 

from the pre-made slide layouts, you 

cannot delete the objects in the layout. 

Statement 3: Blank Slide is at the top of 

the ‘Content Layouts’ area in the Slide 

Layout panel. 

Statement 4: The paragraph tab can be 

used for text alignment and text direction. 

 

a. Statement 2, statement 3 and 

statement 4  

b. Statement 1, statement 3 and 

statement 4 

c. Statement 1, statement 2 and 

statement 4 

d. Statement 1, statement 2 and 

statement 3 

 

44. In context to MS Word, which of the 

following Statement(s) is/are true? 

 

Statement 1: Footnote Text style defines 

characters as 12-point Times New 

Roman and paragraphs as single-spaced 

and right-aligned. 

Statement 2: Footnote Text style defines 

characters as 10-point Times New 

Roman and paragraphs as double-

spaced and left-aligned. 

Statement 3: Footnote Text style defines 

characters as 12-point Times New 

Roman and paragraphs as double-

spaced and right-aligned.  

Statement 4: Footnote Text style defines 

characters as 10-point Times New 

Roman and paragraphs as single-spaced 

and left-aligned.  

 

a. Only statement 4 is true 

b. statement 2 and statement 3 true 

c. statement 1, statement 2 and 

statement 3 are true 

Achievers’ Section (Each Question is 2 Marks) 
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d. Statement 2, statement 3 and 

statement 4 are true 

 

45. In context to MS Word, match the 

following: 

 

 Column A  Column 
B 

a. Alt + Ctrl + C i. Print 
Preview 
View 

b. Ctrl + W ii. Search in 
a 
document 

c. Ctrl + F2 iii. Create a 
copyright 
symbol 

d. Ctrl + F iv. Close a 
document 

 

a. a - iii, b - iv, c - i, d - ii 

b. a - ii, b - iv, c - i, d - iii 

c. a - i, b - iii, c - iv, d - ii 

d. a - iv, b - iii, c - ii, d - i 

 

46. Match the following: 

 

 Column A  Column B 

a. Random 
Access 

i. Magnetic tape 

b. Sequential 
Access 

ii. Magnetic disk 

c. Direct 
Access 

iii. RAM 

 

a. a – iii, b – i, c – ii 

b. a – ii, b – i, c – iii 

c. a – iii, b – ii, c – i 

d. a – ii, b – iii, c – i 

 

47. Identify the term with the help of the 

description given below: 

 

i. It is the fraudulent attempt to obtain 

sensitive information such as 

usernames, passwords and credit 

card details by disguising oneself as 

a trustworthy entity in an electronic 

communication. 

ii. It occurs when an attacker, 

masquerading as a trusted entity, 

dupes a victim into opening an email, 

instant message, or text message. 

iii. It is a cyber-attack that uses 

disguised email as a weapon. 

iv. The term is said to have been coined 

by the well-known spammer and 

hacker in the mid-90s, Khan C Smith. 

 

a. Spoofing b. Phishing 

c. Cracker d. Hacker 

 

48. Match the following: 

 

 Column 

A 

 Column B 

a. Non- 

volatile 

memory 

i. Increased data 

memory 

reliability   

b. Volatile 

memory 

ii. Portable 

storage device 

c. RAID iii. ROM 

d. Pen 

drive 

iv. SRAM 

 

a. a – iii, b – iv, c – i, d – ii 

b. a – iv, b – iii, c – ii, d – i 

c. a – ii, b – iii, c – iv, d – i 

d. a – i, b – iv, c – ii, d – iii 

 

49. Three friends Emma, Eva, and Amelia 

were discussing about Operating 

System. Who among the following is/are 

correct? 

Amelia: Operating System acts as an 

interface between the user and the 

computer. 

Emma: The primary function of an OS is 

to make the most efficient use of the 

computer hardware. 

Eva: An operating system is a software 

which performs all the basic tasks like file 

management, memory management, 

handling input and output etc. 

 

a. Emma 

b. Amelia 
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c. Eva 

d. All the three are correct 

 

50. Fill in the blanks: 

i. As disks have relatively low transfer 

rates and relatively high latency 

rates, disk schedulers must reduce 

latency times to ________. 

ii. With _____ only one process can 

execute at a time; meanwhile all 

other process are waiting for the 

processor. With ______ more than 

one process can be running 

simultaneously each on a different 

processor. 

 

a. (i) reduce data transfer speeds; (ii) 

multiprocessing, multiprogramming 

b. (i) ensure high bandwidth, (ii) single-

tasking, multiprocessing 

c. (i) ensure low bandwidth, (ii) 

multiprogramming, multiprocessing 

d. (i) make sure data is transferred, (ii) 

multiprogramming, multiprocessing 

 

 

Answer Key 
 

1. d 2. d 3. a 4. b 5. b 6. d 7. d 8. d 9. a 10. c 

11. c 12. a 13. a 14. c 15. a 16. c 17. a 18. d 19. b 20. b 

21. b 22. b 23. a 24. a 25. c 26. c 27. c 28. b 29. a 30. a 

31. a 32. b 33. d 34. d 35. d 36. c 37. b 38. b 39. d 40. c 

41. d 42. a 43. b 44. a 45. a 46. a 47. b 48. a 49. d 50. b 
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